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Welcome To nCommand
nCommand is a powerful desktop communication client that is tied into your
company’s phone system, allowing you to call, chat and share with anyone in your
company. Anyone can call you at your extension or your external phone number and
your nCommand client will ring just like a regular phone wherever you are.
But nCommand has way more uses than answering phone calls, so let’s get started.

Installing nCommand
Installing nCommand is easy. Simply download the appropriate client for your
operating system, then complete the following steps:

MAC Installation
•

Use Finder to locate your downloaded client and double-click the file. The
following window will appear.

•
•
•

Drag the nCommand icon over to Applications.
Once copied, open Applications and find the nCommand app.
When launched the first time, a dialog will appear indicating the application
was downloaded from the Internet and confirming if you want to open it.
Click Open to start nCommand.
On first launch, an End User License Agreement will be presented. Review
and click I Agree to continue with the installation, or Cancel to stop the
installation.
The nCommand login screen will then launch.

•
•
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Windows Installation
During the initial installation on Windows, an option is offered to install an Outlook
plug-in. In order for the installation to proceed correctly and work with nCommand,
the installation should be done as an Administrator. Right-click the installation file
and choose Run As Administrator. If you don’t have administrator privileges, see
your IT staff for assistance. Additionally, nCommand must be installed to the default
C: drive location. Do not change the location if using the Outlook plug-in.
•
•
•
•
•
•

•
•

Use Widows Explore to locate your downloaded client and double-click the
file (or right-click and choose Run As Administrator as noted above).
Choose your language for installation.
Click Next in the nCommand Setup box.
The End User License Agreement will be presented. Review and click I Agree
to continue with the installation, or Cancel to stop the installation.
Next, review the installaion options.
If you are running Outlook with an Exchange server, an optional Outlook
Plugin can be installed. You will need to exit Oulook to install this. See the
Additional Windows Features section for more information on installing
the plug-in.
Next, choose the location to install the application and then whether to create
a Start Menu Folder. Click Next and the installation will complete.
When finished, click Next and the Finish to launch nCommand.

Logging In
Once installation is complete, the Login screen will launch.
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Enter your Username and Password to login. Optionally, set the Remember
Password option and/or the Sign in automatically option if you don’t want to enter
the information every time you login.

Windows First Login
When you first login on Windows, two pop-ups will appear offering to configure two
optional features.
•
•

The first is whether you want to set nCommand as your default calling
application on your Windows computer. The choice can be changed later.
The second is whether you want to enable Outlook integration. This will
allow the client to search and import contacts from Outlook, and allow
nCommand to show your presence status as “meeting” during times where
you have a meeting in your Outlook calendar.

Making Your Client Useful
Adding Contacts
When you first login, your Contact list will be empty. By adding contacts, you can
quickly see their status, call them or have a quick chat with them.
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To add contacts, click the directory icon
on the left side, and the list will
change to a directory listing of all numbers or users in your company.
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To add someone as a contact, control-click or right-click on that contact and choose
Add to Contacts.

As a privacy feature, adding another user to your contacts sends that user an invite
request. Your contact will show as Pending until the user accepts your invitation.
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When the user accepts your invitation, you will be able to see their presence status.

Presence Status
In the above, the user is showing offline. There are a number of different statuses
that can appear in the status box.
•
•
•
•

Green – the user is available
Red diagonal lines – busy, meeting or on a call (will indicate “call”)
Orange - away
Emtpy – offline

You can change your status manually by choosing from the drop-down list.

However, your status will update automatically so the most common usage would
be to set yourself busy if you don’t want to be disturbed.

Profile Picture
Now that you have a contact, they might like to see a picture instead of just your
initials. Either control-click/right-click or double-click on the circle with your
initials:
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Choose an image file and click open to see how the image will appear. Images of
many different sizes will be scaled, but make sure that the focus of your image is in
the middle to avoid anything being cut off.

Status Message
If you have a status message, type that into the “What’s on your mind?” field above.
This will show to others. Useful messages might be “Working from home today”,
“Working from the gym today” or “Working from the beach today”.

When you change your status message, others will see your update.
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Editing Contacts
Contacts from your directory are typically other users in your company. The profile
details are based on what is in the company directory. You can add edit other fields
on the contact which are then private to your client. To edit a contact, control-click
or right-click the client, then choose Edit Profile from the menu. A new tab will
appear with the contact information ready to edit.

Most fields can be updated except the users IM address. Click Save to update the
entry.

Adding Your Own Contacts
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You can also add contacts that are not in the company directory. To add a new
contact, click the + sign in the profile box:

A new tab will expand letting you create a new contact for anyone you call
frequently. From here, you can create a new Contact, Group or My Room invitation.
My Room will be reviewed later in this document. Enter the information you want to
have for this contact and click Save. Your new contact will then appear in your list.

Adding Conference Bridge Contacts
You can also create contacts for any conference bridges you routinely call into. To
create a conference bridge contact, click the + sign to create a new contact. Provide a
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display name such as Weekly Bridge. Scroll to the bottom of the entries to edit until
you reach Dial-in Number.

Enter the conference bridge dial-in number, then enter the conference ID and/or
PIN if the bridge has one.
When you double-click the contact or choose call from the menu, the client will call
the conference bridge number, pause, then dial the conference ID, pause again and
then dial the Security PIN. The client adds the usual # to the end of each digit
sequence so you don’t need to enter that as part of the conference ID or security
PIN.
NOTE: The conference ID and security PIN are not strictly used for those purposes.
These fields can be any sequence of digits you routinely use to access a conference
bridge. The client will only dial a digit sequence if something was entered in either
of the fields. If a field is empty, the client will not dial anything for that field.

Voicemail Contact
If you frequently transfer callers to a contact’s voicemail, edit that contact’s profile
and use one of the entries, such as Personal Phone, to enter a digit string that
includes the necessary * code. For example, if that user’s extension is 1001, enter
*551001 as the Personal Phone number.

Favorites
If you have contacts you frequently use, mark these as a Favorite by control-clicking
or right-clicking on that contact and choose Set as Favorite from the menu. This
creates a group name Favorites and keeps this group at the top of your contact list.
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Contact Sorting
By default, contacts are sorted last name first. This can be changed from the toplevel menu by choosing Contacts->Sort by First Name.

Using Groups
Contacts can also be grouped. To create a new Group, click the + sign in the profile
and choose the Group icon.

Once you have a group created, control-click or right-click on a contact, then choose
Add to Group and select the group.

The default My Contacts group will always contain all of your contacts. Any contact
can be added to multiple groups. If you organize all of your contacts into Groups,
then click the up-facing arrow on the My Contacts row to collapse the full list of
contacts.
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Groups are purely for convenience and there is no requirement to use them.

Searching Contacts
The search box lets you quickly find contacts. Just begin typing a number or part of a
name and the list of matches will show with the search part highlighted. The
matches are separated into ones found in your own contacts as well as any matches
in the company directory.

When you find a match you want, move the mouse pointer over the entry and a
menu will appear with quick profile information and your options for contacting
that user.
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If the contact is part of your company, the options are chat, call from your client,
video call from your client, call from your desk phone or view profile information for
this contact. Options for external contacts may include audio calling features.
If you enter a complete number in the search box and press enter, the client will call
that number.

Calling Features
The client exposes many professional calling features that you might normally only
find on a business desk phone.

Answering A Call
When someone calls your phone number or extension, a box will pop-up with
options to answer the call or decline the call. Instead of Answer, the button will
either say Audio or Video depending on if the user is calling you with video enabled.
You can choose to answer the call audio-only or with video.
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Placing A Call
To place a call, hover over any contact and click any of the calling options or simply
click the dialpad icon

on the left to enter a phone number to call.

To use the dialer above, start typing a phone number or click each digit on the
dialer. Choose either the video camera at the bottom left to place a video call from
your client, the middle larger button to place an audio call from your client, or the
desk phone icon on the right to place the call from your desk phone. If you use the
desk phone option, the system will call your desk phone first. When you answer, the
call will be placed to the number you called. This is convenient for avoiding misentered calls on your desk phone as the phone system does the dialing for you.

Call Control Toolbar
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Once a call is active (either a call you’ve placed or a call you’ve received), a toolbar
appears that provides additional control over the call.

The toolbar shows how long the call is active, and provides the following options in
order:
•
•
•
•
•
•
•

Hangup the call
Place the caller on hold (the caller will hear hold music)
Mute your microphone
Transfer the caller
Add additional parties to the call
Park the caller
A more menu that provides these additional options:
o Add video (if the call was started as audio, upgrade to video)
o Set audio device (choose between headset or speakers)
o View Profile
o Add to contacts
o Move to tab (this will open a separate tab)

Transferring Calls
If you have an active call and need to transfer the call to someone else, click the
Transfer button and a new tab will open:
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Begin entering part of a number or user to search for in the search box or type a
complete number or extension. To Transfer the caller immediately, click Transfer
Now. The transfer will complete and your call session will end. If you want to first
speak to the person you will be transferring to, choose one of the Attended options.
This will keep the original caller on hold while you talk to the person you want to
transfer the call to. If they are OK with accepting the transfer, click Complete
Transfer.

Transfer to Voicemail
You can also transfer a caller to a contact’s voicemail by entering *55 followed by
their extension, then clicking Transfer Now. If you search for a contact and you have
added a transfer to voicemail string in that user’s profile, begin searching for the
contact, then click the contact name to expand the list of calling options.
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In the above, click on the Personal Phone field to use the transfer to voicemail string,
then click Transfer Now.

3-Way Calls
If you have an active call, click the Add People icon. This will add a tab with a search
box to add another user to your call. As before, enter part of a name or number and
choose the user, or enter the full number or extension and click Call.
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This places the current user on hold and places the call to the new contact. The
toolbar then changes to reflect that you have two calls with your first call noted as
On Hold.

When you are ready to join everyone together, click the green Merge Call button.
You are now joined in a 3-way call and everyone can speak to each other. The
Toolbar changes to reflect that you have a Group calla and that you are the owner.
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Call Park and Retrieve
To park a call, click the P icon while on an active call.

You can choose to park the call against your own extension or enter another
extension to park the call against. The client handles entering the * code and
extension for you. If the call goes unanswered for too long, the system will ring you
back with an incoming call.
To retrieve a call, use the top-level menu by choosing Calls->Retrieve Parked Call.
Choose the phone to use and the client will place the appropriate call. When you
hear the prompt asking you to enter the extension, click on the Dialpad icon and
enter the # digit if the call was parked against your own extension, or the extension
number that the call was parked against followed by #.

Pull Call
If you have a call that you answered on your desk phone, but would like to transfer
it to your client, use the Pull Call feature. To pull the call from your desk phone to
your client, use Calls->Pull Call from the top-level menu.

Chat
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Chat is easy with nCommand. You can start a chat session with anyone in your
company. Chats can also be upgraded to calling, video and desktop sharing.

Starting a Chat
To begin a chat with a user, look for the chat icon in many different areas in the
client. For example, hover over a contact and the chat icon will show in the lower
left.

Or click the chat icon on the left to find anyone you’ve recently had a chat with.
Double-clicking any contact will have a default action. If you double-click a contact
that is in your company, the default is to open a new chat tab. If the user is outside
your company, the default action is to call them.
When you begin any chat, a new tab will open. Each chat session will open a new
tab. You can close any tab at any time. Starting a chat with someone you already
have chatted with earlier will restore that chat session.
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To send a message, simply type your message in the space at the bottom and press
enter to send your message. A list of emoticons is also available.
Chat history can be viewed or deleted using the options at the top of the chat
session.

The list of available options will change depending on how far back your chat
history goes.

Group Chat
To add others to a chat session, drag-and-drop another contact from your contact
list onto the chat session. You can also add multiple contacts at once by commandclicking or control-clicking each contact in the list to highlight them, then drag-anddrop the group of contacts onto the chat session.
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File Transfer
While you are chatting, you may find you need to transfer a file to someone. Just
click the paper icon in the lower right, then choose a file to send.
The file transfer will appear in the chat window and show the transfer progress. The
person you are sending the file to will need to accept the file to begin the transfer.
Click Cancel Transfer to cancel any file transfer.

Upgrading Your Communication
Many times, you find you need to upgrade your communication to add in voice,
video or even desktop sharing. The chat tab provides one-click access to all of these
features.

Adding Audio
If you are chatting with someone and need to speck with them, click either the
handset icon to call from your desktop client, or the phone icon to call from your
desk phone. Your chat session will continue, but now you will have a mini-toolbar at
the top of the chat session.

This provides quick access to the Hangup, Hold, Mute a More menu.

Adding Video
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If you want to add a video call, click the video camera icon. When you start the video
call, the chat space it replaced with the other uses video feed and navigation options
are added below the video window.

The navigation options let you switch between the video sessions and the chat
session.

Screen Share
The screen share option allows you to share your desktop. Click the Start Sharing
icon. A Preview window will appear that will show you what you are about to share.
If you have multiple monitors, you can choose which display to share if you want to
share that entire desktop. Or, you can choose a single application to share. Once you
have chosen what to share, click Start Sharing.
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While you are sharing, a small control window appears that lets you pause, stop,
choose a different screen or application to share, or hide the preview.

Pausing sharing can be handy when you are sharing your desktop and need to check
email or something else that you don’t want others to see while you are sharing. You
can then resume sharing at any time. Stopping a share still leaves the chat session
tab open so you can continue your communication.

Group Communication
Group communication is easy to manage in nCommand by using the My Room
feature.

My Room
Click the house icon in the profile section to start a My Room tab.

A new tab will open ready for you to add other users.
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Conference Bridge
If you see a message about Audio conference information, you may not be set up for
a conference bridge. If you have a conference bridge you would like to use for group
sessions, the information can be entered in Settings. Click the gear icon
in the
lower left corner of the client. The contact list will be replaced with a series of
settings menus.
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The menu defaults to General settings. Click General, and a menu will appear.
Choose Advanced.

Scroll down until you reach the section titled Call bridge.
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If you have a conference service, enter the phone number used to reach the service.
Enter your Moderator PIN if you have one. If participants have a separate PIN, enter
the participant PIN in PIN 1. As you enter the data, the Room Info section in your My
Room updates.

Calling the Conference Bridge
Once you have the conference bridge information filled out, the calling icons are
enabled. The video icon will remain disabled for group sessions as video
conferencing is not supported.
With the conferencing information filled in, just click either of the phone icons to
initiate a call to the conference bridge. The client will wait a couple seconds, then
dial the Moderator PIN for you. When you add participants to your My Room, they
will be able to click the phone icons as well, but their clients will dial the Conference
ID (participant PIN).
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Adding Contacts to Your My Room
To add contacts, drag them from your contacts or from the directory and drop them
in the chat area. The member list will continue to grow as you add contacts.

The other uses will see a pop-up message that will indicate you want them to join
your room. As users join, they will move from the Pending list to the Joined list.
When you type chat messages, all users will get them, and all users can respond.

The three vertical dots to the right of each name provide additional options, such as
holding a private chat or adding the person to your contacts if they are not already
there.

nCommand User Guide

The Chat window will contain the full chat session between all the members of your
group chat.

Inviting Guests to Your My Room
You can also invite external participants to join your session. The Room Info section
provides links to generate an email with the session information, copy the guest link
to the clipboard or to generate a new guest link.
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If you copy the Guest Link to the clipboard or generate an email, the information
contains the Conference Bridge details, a link for internal users are the Guest Link,
which is an https URL, that anyone can use to join your session. The other users
simply need to enter the link in their web browser to join. They will be presented
with login field in which they enter a first name and last name to login.

As each external guest joins, you will get a pop-up request letting you control who
you add to the room.

Click Accept to allow the guest to join. If you miss a pop-up, the lists of pending
requests also show in your Pending list with a Check or X icon. Just click the Check
to allow this user to join your session.

nCommand User Guide

If you have a larger number of pending requests, the extra menu available on
Participants allows you to accept or decline all pending requests at once. You can
also dismiss any participant as well as get a list of the attendees.

Guests are able to interact using their web browser just like other users, including
chatting and viewing screen shares. Once you accept, they get a brief message
indicating whether their browser is supported and what features are available.
Chrome is the best supported browser.

Once the user clicks Get Started, the right-hand side of the browser window will
show calling information and options, along with the current participant list.
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NOTE: Currently, the Call and Video button are enabled, but are not supported.
The ability to have the system call a guest directly is not be supported. However, the
guest can call the Dial-in-number and enter the Conference ID to join the audio
bridge.
When a guest closes the browser tab their sessions was open in, you will get a
notification in your chat session that they have left the room.

My Room Screen Share
The screen share option is also supported in your My Room just like it is for
individual conversations. This allows your client to be used to do small group
presentations or training session. Other users, including guest users via their web
browser, will be able to see your shared desktop or application.
The same controls are available to pause, stop, change application or collapse the
preview.

Communication History
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Call History
The client contains a call log that shows all of your incoming, outgoing and missed
calls. The Call History section has two tabs – one for your calls and the other for
your voicemails.

The history will show the caller’s name if it was provided along with the caller’s
number. If the caller is a member of your company, their presence status will also be
shown if you have them as a contact. To call someone back, simply double-click the
entry.

Voicemail
When callers leave voicemail, you can review those directly in your client. Using
your client to listen to your voicemails allows you to listen to them in any order,
delete them or even download the recording. You can even call the person back or
create a contact from their information.
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Call Center Integration
If you are part of a call center, nCommand will allow you to login and out of the call
center or change your status. To access the call center options, click Preferences (the
gear icon in the lower left corner), then choose Services from the drop-down list.

From here you can sign-in to the call center, sign-out, make yourself unavailable or
available or change your state to wrap-up. When you sign-in to the call center, you
are signed-in to all the queues that your supervisor has assigned you to.
The call center options can also be accessed by using the top-level menu under
Window->Call Center.
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Team Telephony
Team Telephony is a feature that mimics the Busy Lamp Fields that you may have
on your desk phone. If you do not have a desk phone, or you do not have any Busy
Lamp Fields, then the Team Telephony window will not show.

The Team Telephony window will appear automatically the first time you login if
you have any Busy Lamps configured on your desk phone. By default, the window is
set as Always On Top and it will appear over the top of any other window. The
window has a number of options that let you control how you want it to appear. To
change these options, click Preferences (the gear icon in the lower left corner), then
choose Services from the drop-down menu.

If you close the window, a warning box will appear to let you know you won’t
receive Busy Lamp updates and a note on how to turn it back on. The Team
Telephony configuration can also be accessed from the top-level menus by choosing
Window->Team Telephony. If the option is grayed out, then you do not have any
Busy Lamp Fields configured.
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Call Recording
If you have call recording configured on your seat, the client provides options to
control your call recording.

Once you are on an active call, click the More menu in the toolbar. If call recording is
set to Selectively Record Calls, then Start Recording will be the only option in the
menu. Click Start Recording to begin recording this call.
Once recording has started, the menu changes to Pause Recording. This allows you
to pause a recording when you are about to collect sensitive information. When you
are ready to begin recording again, choose Resume Recording from the menu.

While recording is active, a red dot will appear to the left of the call duration.
Recording will end when the call is over.

Callto: and Tel: URL Schemes
You can use nCommand for making calls using Callto and Tel URL links anywhere in
your machine, but you need to register nCommand as the primary application for
that purpose in the operating system.
On Windows, at first login there is a dialog asking if you would like nCommand to be
the primary calling application for Callto and Tel URL schemes. Answering yes will
modify Windows settings so that the next call using those links will use nCommand.
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If another application should afterwards take precedence in Windows settings, you
can again make nCommand the primary calling application from Preferences,
Outgoing Calls tab.
On OS X, you need to make the same selection in FaceTime preferences. You are
required to log in to FaceTime to change the preferred calling application.

Additional Windows Features
nCommand on Windows offers some additional features when used with an Outlook
client if the Outlook integration is enabled. To use these features, make sure to run
the installation program as an Administrator as noted in the installation section. The
contact search and calendar integration can be disabled or enabled in the
Preferences section under Extensions. The client and/or Outlook will need to be
restarted when changing these options.
The Preferences section also includes additional Extensions settings for use with
headsets.

Outlook Contact Search and Import
When searching contacts in the directory, a separate Outlook group will. Enter
names in the same search box as before to locate contacts you may have stored in
Outlook. Contacts must be in your own contact list for the search to find them.
Searching the Exchange server is not supported.
Once you locate a contact, you can right-click on the user and add them into your
contact list. You can then further edit any missing information. You must add each
user in your Outlook contact list separately.

Outlook Calendar Integration
nCommand can monitor your Outlook calendar. When you have a meeting, your
presence status will show as busy, with the text “meeting” next to the status box.
Calling has precedence over the meeting status, so if you are on a call, your status
will change to “call”. If you end your call before your meeting time ends, your status
will change back to “meeting” until your scheduled meeting time is over.
Appointment information is updated on one-minute intervals.
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Outlook Plug-In
The Outlook Plug-in installs additional capabilities into your Outlook client. For
users that are also nCommand users, presence status can be seen next to user’s
names in Outlook any time you are creating an email, viewing their contact info, etc.
Additionally, features like chat and call options are enabled in Outlook. Rightclicking or hovering over an email address will bring up user information in Outlook
where a chat icon and calling icons (may be in a drop-down menu) are added.
If the chat option is clicked, a new tab is opened in nCommand to begin your chat
session. If a call option is chosen, the nCommand client is used to place the call to
that contact.
If these options aren’t working, check in the Extensions section in Preferences. The
status of each of the plug-ins should be Connected: Yes. If not, exit both nCommand
and Outlook, then restart nCommand first followed by Outlook.

Headsets
Some headsets ship with their own software and offer integration to Broadsoft UCOne Communicator. Make sure to install the vendor’s software after you complete
the nCommandion installation. If your headset vendor supports this client, the
software will work with nCommand. You may need to enable the vendor’s extension
and disable the default Broadsoft extension for USB devices.
To do this, go to Preferences and the Extensions menu. Under Manage Extensions,
verify if the vendor’s software has added an extension in this section. The default
Broadsoft extension will be named USB Device Add-in, with the vendor name as
Broadsoft, Inc. Move the slider to the disable position to stop using this extension
and enable the vendor’s extension if present. Restart nCommand after making the
settings change.
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